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Creating and Editing a Document
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Objectives

After completing this lab, you will know how to:

Develop a document as well as enter and edit text.
Insert and delete text and blank lines.

Use spelling and grammar checking.

Use AutoCorrect.

Cut and copy text.

Change fonts and type sizes.

Bold and color text.

Change alignment.

Insert and size pictures.

Print a document.

Use a template.
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CASESTUDY

=Adventure Travel Tours

As a recent college graduate, you have accepted a job
as advertising coordinator for Adventure Travel Tours, a
specialty travel company that organizes active adven-
ture vacations. The company is headquartered in Los
Angeles and has locations in other major cities through-
out the country. You are responsible for coordination of
the advertising program for all locations. This includes
the creation of many kinds of promotional materials:
brochures, flyers, form
letters, news releases,
advertisements, and a
monthly newsletter. You
are also responsible for
creating Web pages
for the company Web
site.

Adventure  Travel
Tours is very excited
about four new tours
planned for the upcom-
ing year. They want to
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promote them through informative presentations held
throughout the country. Your first job as advertising
coordinator will be to create a flyer advertising the
four new tours and the presentations about them.
The flyer will be modified according to the location of
the presentation.
The software tool you will use to create the flyer
is the word processing application Microsoft Office
Word 2010. It helps
you create docu-
ments such as letters,
reports, and research
papers. In this lab, you
will learn how to enter,
edit, and print a docu-
ment while you create
the flyer (shown right)
to be distributed in a
mailing to Adventure
Travel Tours clients.
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Entering and editing text is
simplified with many of Word’s
AutoCorrect features.

Formatting enhances
the appearance of a
document.

Pictures add visual interest to a
document.
WD1.3
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Concept Preview

wD1.4

Word 2010

‘Creating New Documents

Adventure Travel Tours has recently upgraded their computer systems at
many of their locations across the country. As part of the upgrade, they have
installed the latest version of the Microsoft Office 2010 suite of applications.
You are very excited to see how this new and powerful application can help
you create professional letters and reports as well as eye-catching flyers and
newsletters. Your first project with Adventure Travel Tours is to create a flyer
about four new tours.

DEVELOPING A DOCUMENT

The development of a document follows several steps: plan, enter, edit, format,
and preview and print.

Plan The first step in the development of a document is to understand the purpose of the
document and to plan what your document should say.

Enter After planning the document, you enter the content of the document by typing the text
using the keyboard.
Edit While creating a document, you will need to edit it to correct typing, spelling, and

grammar errors. You will also probably spend much time revising the document by
adding and deleting information and by reorganizing it to make the meaning clearer.

Format Enhancing the appearance of the document by formatting the text makes it more
readable and attractive and makes it easier to find information and emphasize important
points. This is usually performed when the document is near completion, after all edits
and revisions have been completed. It includes many features such as boldfaced text,
italics, and bulleted lists.

Preview and Print The last step is to preview and print the document. When previewing, you check the
document’s overall appearance and make any final changes before printing.
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Start Word 2010.

If necessary,
maximize the Word
2010 application
window.

Your screen should be similar to
Figure 1.1

Having Trouble?

See “Common Interface Features,” on
page 10.14, for information on how to
start the application and use features
that are common to all Office 2010
applications.

Blank document is displayed
in document window

Additional Information

The Ribbon may display additional tabs
if other application add-ins associated
with Office are enabled.

Additional Information

If the ruler is not displayed, click
View Ruler above the vertical scroll bar
to turn it on. You also can temporarily
display the horizontal or vertical ruler
by pointing to the top or left edge of the
document window.

Additional Information

The mouse pointer also may appear in
other shapes, depending upon the task
being performed.

You will find that you will generally follow these steps in the order listed
above for your first draft of a document. However, you will probably retrace
steps such as editing and formatting as the final document is developed.

During the planning phase, you spoke with your manager regarding the
purpose of the flyer and the content in general. The primary purpose of the
flyer is to promote Adventure Travel’s new tours. A secondary purpose is to
advertise the company in general.

You plan to include specific information about the new tours in the flyer as
well as general information about Adventure Travel Tours. The content also
needs to include information about the upcoming new tour presentations.
Finally, you want to include information about the Adventure Travel Web site.

EXPLORING THE WORD 2010 WINDOW

You will use the word processing application Microsoft Office Word 2010 to
create a flyer promoting the new tours and presentations.

Ribbon

/ D

Home tab File name

I
AN

Horizontal ruler

| N

Insertion point

Mouse pointer

Click to display/hide rulers

<«—  Vertical ruler

Figure 1.1

The Word 2010 Ribbon below the title bar displays command tabs that pro-
vide access to the commands and features you will use to create and modify a
document.

The large area below the Ribbon is the document window. It currently dis-
plays a blank Word document. The insertion point, also called the cursor, is
the blinking vertical bar that marks your location in the document. A vertical
and horizontal ruler may be displayed along both edges of the document win-
dow. The horizontal ruler at the top of the document window shows the line
length in inches and is used to set margins, tab stops, and indents. The vertical
ruler along the left edge shows the page length in inches and shows your line
location on the page.

The mouse pointer may appear as an I-beam (see Figure 1.1) or a left- or
right-facing arrow, depending on its location in the window. When it appears
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Move the mouse

as an I-beam, it is used to move the cursor, and when it appears as an arrow, it
is used to select items.

Mouse pointer

pointer into the left
edge of the blank
document to see it
appear as 1.

Move the mouse
pointer to the Ribbon
to see it appear as [; .

Your screen should be similar
to Figure 1.2

Status bar —>|

Additional Information

You also can change views using
commands in the Document Views

Print Layout view Current zoom
is current view percentage
Page count Word count
indicator indicator View buttons Zoom feature
Figure 1.2

CHANGING THE DOGUMENT VIEW

The status bar at the bottom of the window displays the page and word count
indicators. The page indicator identifies the page of text that is displayed
onscreen of the total number of pages in the document. The word count indi-
cator displays the number of words in a document. When you first start Word,

group of the View tab.
a new blank document consisting of a single page and zero words is opened.
The right end of the status bar displays five buttons that are used to change
the document view and a document zoom feature. Word includes several
views that are used for different purposes. The different document views are
described in the table below.
Caution |

Print Layout Shows how the text and objects will appear on the printed page.

This is the view to use when adjusting margins, working in columns,
drawing objects, and placing graphics.

Full Screen Reading Shows the document only, without Ribbon, status bar, or any other
features. Uselul for viewing and reading large documents. Use to
review a document and add comments and highlighting.

Web Layout Shows the document as it will appear when viewed in a Web browser.
Use this view when creating Web pages or documents that will be
displayed on the screen only.

Outline Shows the structure of the document. This is the view to use to plan
and reorganize text in a document.

Draft Shows text formatting and simple layout of the page. This is the best
view to use when typing, editing, and formatting text.
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Additional Information

Pointing to the items on the status bar
displays a ScreenTip that identifies the
feature.

? Drag the Zoom Slider

to the left to reduce
the zoom until the
entire page is visible.

Having Trouble?

See “Using the Zoom Feature” on page
10.33 in the Introduction to Microsoft
Office 2010 to review the document
zoom feature.

Your screen should be similar
to Figure 1.3

1-inch top and
bottom margins

Print Layout view is the view you see when first starting Word or opening a
document. You can tell which view is in use by looking at the view buttons.
The button for the view that is in use appears highlighted (see Figure 1.2).
The zoom setting for each view is set independently and remains in effect
until changed to another zoom setting. Initially the zoom percentage for Print
Layout view is 100%. At this percentage, the document appears as it will when
printed.

You will “zoom out” on the document to see the entire page so you can bet-
ter see the default document settings.

1-inch left and right margins

:I | |
\
/ Text space of
6.5 inches

-~

Entire page
is visible

Text space —>

Click to decrease

\ in 10% increments

] '

t

Drag Zoom Slider to
change percentage

Figure 1.3

At this zoom percentage, the entire page is displayed and all four edges of the
paper are visible. It is like a blank piece of paper that already has many pre-
defined settings. These settings, called default settings, are generally the most
commonly used settings. The default settings include a standard paper-size
setting of 8.5 by 11 inches, 1-inch top and bottom margins, and 1-inch left and
right margins.

You can verify many of the default document settings by looking at the
information displayed in the rulers. The shaded area of the ruler identifies the
margins and the white area identifies the text space. The text space occupies
6.5 inches of the page. Knowing that the default page size is 8.5 inches wide,
this leaves 2 inches for margins: 1 inch for equal-sized left and right margins.
The vertical ruler shows the entire page length is 11 inches with 1-inch top and
bottom margins, leaving 9 inches of text space.

You will use Draft view to create the flyer about this year’s new tours. You
will use the View tab to change both the view and the Zoom percentage.

WD1.7
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Open the View tab.

From the Document
Views group,

click

® If necessary, choose
Ruler in the Show
group to display the
ruler.

Having Trouble?

Click the box next to an option to select
or deselect (clear the checkmark).

l From the Zoom group,
click

Your screen should be similar
to Figure 1.4

Additional Information

The vertical ruler is not displayed in
Draft view.

First line indent marker Select to display ruler Right indent marker
‘// :
\ Left margin boundary at 0 Right margin boundary at 6.5

End-of-file marker

Page margins not displayed —>»

«——  Vertical ruler not displayed

Current zoom percent

|

Increasing the zoom to page width increases the magnification to 154% and
displays the full text area in the document window. In Draft view, the margins
and the edges of the page are not displayed. This allows more space on the
screen to display document content. This view also displays the end-of-file
marker, the solid horizontal line that marks the last-used line in a document.

The ruler also displays other default settings. The symbol 7 at the zero posi-
tion is the first-line indent marker and marks the location of the left paragraph
indent. The £ symbol on the right end of the ruler line at the 6.5-inch position
marks the right paragraph indent. Currently, the indent locations are the same
as the left and right margin settings.

Figure 1.4

_Entering Text

Now that you understand the purpose of the flyer and have a general idea of
the content, you are ready to enter the text. As you type, you will probably
make simple typing errors that you want to correct. Word includes many fea-
tures that make entering text and correcting errors much easier. These fea-
tures include checking for spelling and grammar errors, auto correction, and
word wrap. You will see how these features work while entering the title and
first paragraph of the flyer.

TYPING TEXT

The first line of the flyer will contain the text “Adventure Travel Tours New
Adventures.” As you enter this line of text, include the intentional error identi-
fied in italic.

wpD1.8 Lab 1: Creating and Editing a Document WWW.MHHE.COM/OLEARY
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? Type Adventure

Traveel (do not
press space after
typing the last letter).

T

Cursor shows where next

Having Trouble?

To review the basics of moving the
cursor and editing a document, refer to character you type will appear
the “Entering and Editing Text” section
on page 10.34 of the Introduction to
Microsoft Office 2010.

Your screen should be similar
to Figure 1.5

Number of words in document

Additional Information

The status bar also can display additional
information such as the horizontal
position of the cursor on the line and the
line number. To customize the status bar,
?E%QESJ;CKJS?’V?:%?SI’?; 1‘:}?::%?3 Notice that the status bar now tells you that there are two words in the document.
' pay Next, you need to correct the typing error by deleting the extra e in the word

status bar context menu.
travel. Then you will complete the first line of the flyer.

Figure 1.5

Press («) or position
the I-beam between
the e and | and click.

® Press to
remove the extra e.

©® Press (=) or click at
the end of the line.

I Press (Spacebar).

Type Tours

four new
adventures

and correct any
typing errors as you
make them using

or (Delete).

® With the cursor
positioned at the
end of the line, press Figure 1.6

3 times.

Blank lines inserted by pressing

The first line of the flyer is now complete. Pressing the first ended the
first line of text and inserted a blank line. The next two inserted blank lines.
Your screen should be similar
to Figure 1.6
Entering Text WwD1.9
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? Open the Home tab

and click [ 7 | Show/
Hide in the Paragraph
group.

Another Method

You also can use the keyboard shortcut
+ * to display formatting marks.

Your screen should be similar
to Figure 1.7

REVEALING FORMATTING MARKS

While creating a document, Word automatically inserts formatting marks
that control the appearance of your document. These marks are not displayed
automatically so that the document is not cluttered. Sometimes, however, it
is helpful to view the underlying formatting marks. Displaying these marks
makes it easy to see, for example, if you have added an extra space between
words or at the end of a sentence.

Displays formatting marks

/

f ™~

End line by pressing (Ent
Entered space by ine by pressing

pressing

Inserted blank lines by pressing

Figure 1.7

The document now displays the formatting marks. The 1 paragraph mark
character on the line above the cursor represents the pressing of that
created the blank line. The 1 character at the end of the text represents the
pressing of that ended the line and moved the cursor to the beginning of
the next line. Between each word, a dot shows where the was pressed.
Formatting marks do not appear when the document is printed. You can con-
tinue to work on the document while the formatting marks are displayed, just
as you did when they were hidden.

You have decided you want the flyer heading to be on two lines, with the
words “four new adventures” on the second line. To do this, you will insert a
blank line after the word Tours. You will move the cursor to the location in the
text where you want to insert the blank line.

WD1.10 Lab 1: Creating and Editing a Document WWW.MHHE.COM/OLEARY
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? Click to the left of the

dot after the “s” in

“Tours”.

<
Ended line

Inserted blank line

I Press 2 times.
Press to

remove the space \

at the beginning of Green wavy line indicates a grammar error
the line.

©® Press(y).

Your screen should be similar
to Figure 1.8

Indicates an error
in the document

'

Figure 1.8

All the text to the right of the cursor when you pressed moved down to
the beginning of the next line. Then as you continued to work on the docu-
ment, the formatting marks adjusted automatically.

Identifying and Correcting Errors Automatically

Having Trouble? Notice that a green wavy underline appears under the word “four.” This indi-

If the green underline is not displayed, cates an error has been detected. .

open the File tab, lick [, As you enter text, Word constantly checks the document for spelling and

Proofing, and select the “Check speling ~ grammar errors. The Spelling and Grammar Status icon in the status bar dis-

as you type”, “Mark grammar errorsas.~~ plays an animated pencil icon [ | while you are typing, indicating Word is

Zg:"%p‘?,"aa{i‘gr:sc"ec" grammar with checking for errors as you type. When you stop typing, it displays either a blue
S checkmark [ ], indicating the program does not detect any errors, or a red

X [ ], indicating the document contains an error.

In many cases, Word will automatically correct errors for you. In other
cases, it identifies the error by underlining it. The different colors and designs
of underlines indicate the type of error that has been identified. In addition to
identifying the error, Word provides suggestions as to the possible correction
needed.

CHECKING GRAMMAR

In addition to the green wavy line under “four,” the Spelling and Grammar
Status icon appears as [__] in the status bar. This indicates that a spelling or
grammar error has been located. The green wavy underline below the error
indicates it is a grammar error.

Identifying and Correcting Errors Automatically wp1.11
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Cﬂﬂcept u Grammar Checker

The grammar checker advises you of incorrect grammar as you create and edit a document, and proposes
possible corrections. Grammar checking occurs after you enter punctuation or end a line. If grammatical errors
in subject-verb agreements, verb forms, capitalization, or commonly confused words, to name a few, are
detected, they are identified with a wavy green line. You can correct the grammatical error by editing it or you
can open the context menu for the identified error and display a suggested correction. Because not all identified
grammatical errors are actual errors, you need to use discretion when correcting the errors.

? Right-click the word

“four” to open the
context menu.

Having Trouble?

Review context menus in the “Common
Office 2010 Features” section on page
10.51 in the Introduction to Microsoft
Office 2010. If the wrong context menu
appears, you probably did not have the
|-beam positioned on the error with the
green wavy line. Press or click
outside the menu to cancel it and try
again.

Your screen should be similar
to Figure 1.9

Additional Information

You will learn about using the Mini
toolbar shortly.

Additional Information

A dimmed menu option means it is
currently unavailable.

<—  Mini toolbar

<\

™~

Right-click on error to see suggested

correction in context menu

Available options

Figure 1.9

The Word Mini toolbar and a context menu containing commands related
to the grammar error are displayed. The first item on the menu is the sug-
gested correction, “Four.” The grammar checker indicates you should capi-
talize the first letter of the word because it appears to be the beginning of a
sentence. It also includes four available commands that are relevant to the
item, described below.

Tgnore Once Instructs Word to ignore the grammatical error in this sentence.
Grammar Opens the grammar checker and displays an explanation of the error.
About This Sentence Provides help about the grammatical error.

Look up Looks up word in dictionary.

To make this correction, you could simply choose the correction from the
menu and the correction would be inserted into the document. Although, in
this case, you can readily identify the reason for the error, sometimes the rea-
son is not so obvious. In those cases, you can open the grammar checker to
find out more information.

wbD1.12 Lab 1: Creating and Editing a Document WWW.MHHE.COM/OLEARY
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? Choose Grammar.

Your screen should be similar
to Figure 1.10

Line containing
error is selected

ciek ]

Move to the blank
line at the end of the
document.

Your screen should be similar
to Figure 1.11

Additional Information

Moving the cursor using the keyboard
or mouse deselects or removes the
highlight from text that is selected.

/

Type of error —>»

/

Location of error

Suggested correction

Click to
<— make suggested

correction

Figure 1.10

The Grammar dialog box identifies the type and location of the grammati-
cal error in the upper text box and the suggested correction in the Sugges-
tions box. The line in the document containing the error is also highlighted
(selected) to make it easy for you to see the location of the error. You will make
the suggested change.

Text deselected

Error corrected
by capitalizing “F”

No more errors

located

'

Figure 1.11

The error is corrected, the wavy green line is removed, and the Spelling and
Grammar Status icon returns to[__|.

Identifying and Correcting Errors Automatically WwD1.13
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CHECKING SPELLING

Now you are ready to type the text for the first paragraph of the flyer. Enter the
following text, including the intentional spelling errors.

Type Attention

adventire
travellars!
Press (Spacebar].
Misspelled words identified
Your screen should be similar /\
to Figure 1.12

Errors located

'

Figure 1.12

As soon as you complete a word by entering a space, the program checks the
word for spelling accuracy.

C(lllcepl U Spelling Checker

The spelling checker advises you of misspelled words as you create and edit a document, and proposes pos-
sible corrections. The spelling checker compares each word you type to a main dictionary of words supplied
with the program. The main dictionary includes most common words. If the word does not appear in the main
dictionary, it then checks the custom dictionary. The custom dictionary consists of a list of words such as
proper names, technical terms, and so on, that are not in the main dictionary and that you want the spelling
checker to accept as correct. Adding words to the custom dictionary prevents the flagging as incorrect of spe-
cialized words that you commonly use. Word shares custom dictionaries with other Microsoft Office applications
such as PowerPoint.

If the word does not appear in either dictionary, the program identifies it as misspelled by displaying a red
wavy line below the word. You can then correct the misspelled word by editing it. Alternatively, you can display
a list of suggested spelling corrections for that word and select the correct spelling from the list to replace the
misspelled word in the document.

Word automatically identified the two words “adventire travellars” as misspelled by underlining them with a
wavy red line. The quickest way to correct a misspelled word is to select the correct spelling from a list of sug-
gested spelling corrections displayed on the context menu.

wp1.14 Lab 1: Creating and Editing a Document WWW.MHHE.COM/OLEARY
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Right-click on
“adventire” to display
the context menu.

Another Method

You also can position the cursor on the
item you want to display a context menu
for and press + to open the

menu.

< St ted corrections
Your screen should be similar
to Figure 1.13 -— Context menu

Figure 1.13

A context menu containing suggested correct spellings is displayed. The con-
text menu also includes several related menu options, described in the follow-
ing table.

Ignore Instructs Word to ignore the misspelling of this word for this occurrence only.
TIgnore All Instructs Word to ignore the misspelling of this word throughout the rest of this session.

Add to Dictionary ~ Adds the word to the custom dictionary list. When a word is added to the custom diction-
ary, Word will always accept that spelling as correct.

AutoCorrect Adds the word to the AutoCorrect list so Word can correct misspellings of it automatically
as you type.

Language Sets the language format, such as French, English, or German, to apply to the word.

Spelling Starts the spell-checking program to check the entire document.

Look Up Searches reference tools to locate similar words and definitions.

Sometimes there are no suggested replacements because Word cannot
locate any words in its dictionary that are similar in spelling; or the sugges-
tions are not correct. If this occurs, you need to edit the word manually. In this
case, the first suggestion is correct.

Identifying and Correcting Errors Automatically WD1.15
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Choose “adventure”.

Correct the spelling
for “travellars”.

Your screen should be similar
to Figure 1.14

AV

Selected corrections
replace misspelled words

No spelling or
grammar error

'

Figure 1.14

The spelling corrections you selected replace the misspelled words in the doc-
ument. The Spelling and Grammar status icon returns to [ ], indicating that,
as far as Word is able to detect, the document is free from errors.

USING AUTOCORRECT

As you have seen, as soon as you complete a word by entering a space or
punctuation, the program checks the word for grammar and spelling accu-
racy. Also, when you complete a sentence and start another, additional checks
are made. Many spelling and grammar corrections are made automatically for
you as you type. This is part of the AutoCorrect feature of Word.

Conce pt U AutoCorrect

The AutoCorrect feature makes some basic assumptions about the text you are typing and, based on these
assumptions, automatically corrects the entry. The AutoCorrect feature automatically inserts proper capitalization
at the beginning of sentences and in the names of days of the week. It also will change to lowercase letters any
words that were incorrectly capitalized because of the accidental use of the key. In addition, it also cor-
rects many common typing and spelling errors automatically.

One way the program automatically makes corrections is by looking for certain types of errors. For example,
if two capital letters appear at the beginning of a word, Word changes the second capital letter to a lowercase
letter. If a lowercase letter appears at the beginning of a sentence, Word capitalizes the first letter of the first
word. If the name of a day begins with a lowercase letter, Word capitalizes the first letter. When Spelling Checker
provides a single suggested spelling correction for the word, the program will automatically replace the incorrect
spelling with the suggested replacement.

Another way the program makes corrections is by checking all entries against a built-in list of AutoCorrect
entries. If it finds the entry on the list, the program automatically replaces the error with the correction. For
example, the typing error “withthe” is automatically changed to “with the” because the error is on the AutoCor-
rect list. You also can add words to the AutoCorrect list that you want to be automatically corrected.

WD1.16 Lab 1: Creating and Editing a Document WWW.MHHE.COM/OLEARY
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Enter the following text, including the errors (identified in italics).

E Press to move to

the end of the line.

I Press (Enter).

Type attend a
presentaation

to lern \ / Separated into two words

Spelling error located

aboutthe
© Press (Spacebar). I
Spelling automatically corrected
Your screen should be similar First letter capitalized
to Figure 1.15

Having Trouble?

The “Capitalize first letter of sentences”
and “Replace text as you type” l
AutoCorrect features must be on. Open

the File tab, click[ ], Proofing,
[ ] andselectthese Figure 1.15

options if necessary.

Errors located

The first letter of the word “attend” was automatically capitalized because,
as you were typing, the program determined that it is the first word in a sen-
tence. In a similar manner, it corrected the spelling of “presentation” and sepa-
rated the words “about the” with a space. The AutoCorrect feature corrected
the spelling of “presentation” because it was the only suggested correction for
the word supplied by the Spelling Checker. The word “lern” was not corrected
because there are several suggested spelling corrections.

When you rest the mouse pointer near text that has been corrected auto-
matically or move the cursor onto the word, a small blue box appears under
the first character of the word. The blue box changes to the AutoCorrect
Options button when you point to it.

Identifying and Correcting Errors Automatically WD1.17
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Point to the word
“Attend” to display
the blue box.

Having Trouble?
If your screen does not display the blue

box, open the File tab, click[ ],
Proofing, | and select

the Show AutoCorrect Options buttons
check box.

Point to the blue box.

Click [# -]

AutoCorrect Options.

Your screen should be similar
to Figure 1.16

Another Method
You also can open the File tab,

click[_____], Proofing,
I L |to
add a word to the exceptions list.

AutoCorrect Options button displays when you point to the
blue box below a word that has been automatically corrected

AutoCorrect

Options menu

Figure 1.16

Each time Word uses the AutoCorrect feature, the AutoCorrect Options button
is available. The AutoCorrect Options menu allows you to undo the AutoCor-
rection or to permanently disable the AutoCorrection for the remainder of
your document. The Control AutoCorrect Options command is used to change
the settings for this feature. In some cases, you may want to exclude a word
from automatic correction. You can do this by adding the word to the excep-
tions list so the feature will be disabled for that word. If you use to
delete an automatic correction and then type it again the way you want it to
appear, the word will be automatically added to the exceptions list.

You want to keep all the AutoCorrections that were made and correct the
spelling for “lern”.

Click outside the menu to close it.

Open the spelling context menu for “lern” and choose “learn”.

The spelling is corrected, and the spelling indicator in the status bar indicates
that the document is free of errors.

=Using Word Wrap

Now you will continue entering more of the paragraph. As you type, when the
text gets close to the right margin, do not press to move to the next line.
Word will automatically wrap words to the next line as needed.

WD1.18 Lab 1: Creating and Editing a Document WWW.MHHE.COM/OLEARY
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Concept u Word Wrap

The word wrap feature automatically decides where to end a line and wrap text to the next line based on the
margin settings. This feature saves time when entering text because you do not need to press at the end
of a full line to begin a new line. The only time you need to press is to end a paragraph, to insert blank
lines, or to create a short line such as a salutation. In addition, if you change the margins or insert or delete text
on a line, the program automatically readjusts the text on the line to fit within the new margin settings. Word
wrap is common to all word processors.

E Press to move to

the end of the line.

® Type earth’s
greatest
unspoiled
habitats and
find out how
you can
experience the
adventure of a
lifetime.

® Correct any spelling
Or grammar errors
that are identified.

Your screen should be similar
to Figure 1.17

Additional Information

Generally, when using a word processor,
separate sentences with one space
after a period rather than two spaces,
which was common when typewriters
were used.

Additional Information

You can continue typing to ignore the
date suggestion.

Enter the following text to complete the sentence.

Right margin boundary —

\ Text wrapped automatically

to next line

Figure 1.17

The program has wrapped the text that would overlap the right margin to the
beginning of the next line.

You have a meeting you need to attend in a few minutes and want to con-
tinue working on the document when you get back. You decide to add your
name and the current date to the document. As you type the first four char-
acters of the month, Word will recognize the entry as a month and display
a ScreenTip suggesting the remainder of the month. You can insert the sug-
gested month by pressing (Enter]. Then enter a space to continue the date and
another ScreenTip will appear with the complete date. Press again to
insert it.
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Move to the end of
the sentence and

press twice.

Type your name

Press (Enter).

Type the current
date beginning
with the month and
when the ScreenTips
appear for the month
and the complete

date, press to
insert them.

I Press twice.

Click [ ¥T | Show/Hide
to turn off the display
of formatting marks.

Your screen should be similar
to Figure 1.18

Having Trouble?

Review saving files in the “Saving
a File” section on pg. 10.52 in the
Introduction to Microsoft Office 2010.

Turn off the display of formatting marks

/A

Figure 1.18

As you have seen, in many editing situations, it is helpful to display the for-
matting marks. However, for normal entry of text, you will probably not need
the marks displayed. Now that you know how to turn this feature on and off,
you can use it whenever you want when entering and editing text.

Before leaving to attend your meeting, you want to save your work to a file.
You will name the file Flyer and use the default document type (.docx).
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? New file name
Click @ Save in the /

Quick Access Toolbar.

® Select the location
where you want to
save your file.

® If necessary, drag to
select the proposed
file name in the File
Name text box to
highlight the text.

I Type Flyer.

cick[ Jto
save your document
as a Word document.

Your screen should be similar
to Figure 1.19

Figure 1.19

The document is saved as Flyer.docx at the location you selected, and the new
file name is displayed in the Word title bar.
Finally, you want to close the document while you attend your meeting.

? OpentheFiletaband click] |,

M Now the Word window displays an empty document window.
aving Trouble?

Review closing files in the “Closing
a File” section on pg. 10.60 in the
Introduction to Microsoft Office 2010.

_Editing Documents

You asked your assistant to enter the remaining information in the flyer for
you while you attended the meeting. Upon your return, you find a note from
your assistant on your desk. The note explains that he had a little trouble
entering the information and tells you that he saved the revised file as Flyer1.
You want to open the file and continue working on the flyer.
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Open the File tab and

click| ]

Having Trouble?

Review opening files in the “Opening
a File” section on pg. 10.28 in the
Introduction to Microsoft Office 2010.

Select the location
containing your data
files.

Click to scroll down
Select wd01_Flyer1. through document

Click[ .

Scroll the document
window to see the
entire contents of the \
flyer.

Cursor moved to last line
Click anywhere in the

last line to move the Figure 1.20
cursor.

The file containing the additional content you asked your assistant to add
Your screen should be similar to the flyer is opened and displayed in the document window. After looking
to Figure 1.20 over the flyer, you have identified several errors that need to be corrected and
changes you want to make to the content. The changes you want to make are

shown below.
Having Trouble?

Review how to navigate a document in
the “Scrolling the Document Window”
section on page 10.30 of the Introduction

Capitalize first lett
to Microsoft Office 2010. L LT

Delete word

\

Combine paragraphs

Add “and times”
Rearrange order Delete word

of tours / Delete junk text \

Change to “held” Delete sentence
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Additional Information

You can replace existing text using
Overtype mode, in which each character
you type replaces an existing character.
This feature is turned on by opening the
File tab, then clicking |,
Advanced, and then selecting Use
overtype mode.

E Press +
to move to the top of
the document.

® Move the cursor to
the “a” in “are” in the
first sentence of the
paragraph below the
list of tours.

Additional Information

Throughout these labs, when instructed
to move to a specific letter in the text,
this means to move the cursor to the left
side of the character.

Type and times

Press (Spacebar).

Your screen should be similar
to Figure 1.21

Additional Information

If necessary, refer to the section
“Selecting Text” on page 10.37 in the
Introduction to Microsoft Office 2010
to review this feature.

INSERTING AND REPLACING TEXT

As you check the document, you see that the first sentence of the paragraph
below the list of trips is incorrect. It should read: “Presentation dates and
times are . . . ” The sentence is missing the words “and times.” In addition, you
want to change the word “made” to “held” in the following sentence. These
words can easily be entered into the sentence without retyping the entire line.
This is because Word uses Insert mode to allow new characters to be inserted
into the existing text by moving the existing text to the right to make space
for the new characters. You will insert the words “and times” after the word
“dates” in the first sentence.

Text inserted Word wrap automatically

readjusts text on line

v ~

Figure 1.21

The inserted text pushes the existing text on the line to the right, and the word
wrap feature automatically readjusts the text on the line to fit within the mar-
gin settings.

In the second sentence, you want to change the word “made” to “held.” You
could delete this word and type in the new word, or as you will do next, you
can select the text and type the new text.

WD1.23

Editing Documents



Essentials of Computers and Software

Double-click on
“made” in the next
sentence.

Having Trouble?

If you accidentally select the wrong text,
simply click anywhere in the document

or press any directional key to clear the
selection.

l Type held

Your screen should be similar
to Figure 1.22

Move to the “A”

of “Attend” at the
beginning of the first
paragraph.

Press (Backspace)-

Your screen should be similar
to Figure 1.23

New text replaced selected text

/
I

As soon as you began typing, the selected text was automatically deleted. The
new text was inserted in the line just like any other text.

DELETING TEXT

As you continue proofreading the flyer, you see several changes you would
like to make. The first change is to combine the line “Attention adventure
travellers!” with the text in the following paragraph. To do this, you need to
delete the paragraph mark symbol 1 after the text “travelers!”.

Figure 1.22

Paragraph mark deleted and

Y

Paragraphs combined

Figure 1.23
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Additional Information

The + key combination
deletes text to the left of the cursor

to the beginning of the next group of
characters.

Move to “f” in
“four” in the second
sentence below the

list of tours.
Press (Ctrl] + (Delete).

Having Trouble?
Hold down while pressing (Delete].

Your screen should be similar
to Figure 1.24

You deleted the 1 that ended the previous line and the paragraph has now
moved up to the line above.

You next want to delete the word “four” from the second sentence in the
paragraph below the list of tours. The + key combination deletes
text to the right of the cursor to the beginning of the next group of characters.
In order to delete an entire word, you must position the cursor at the begin-
ning of the word.

Entire word deleted

using +

7

Junk text to
be deleted

Figure 1.24

The word “four” has been deleted.

You see that the end of the same sentence contains a section of junk charac-
ters. To remove these characters, you could use (Delete] and (Backspace] to delete
each character individually, or + or + to delete each
word or group of characters. This is very slow, however. Several characters,
words, or lines of text can be deleted at once by first selecting the text and then
pressing (Delete).

The section of characters you want to remove follows the word “hotel” in
the same sentence. You also decide to delete the entire last sentence of the
paragraph.

WD1.25
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? Move to “2”

(following the word
“hotel”).

© Drag to the right until
all the text including
the space before the
word “locations” is
highlighted.

Having Trouble?

Hold down the left mouse button while
moving the mouse to drag.

Additional Information

When you start dragging over a word,
the entire word including the space after
it is automatically selected.

Press (Delete).

Hold down and
click anywhere in
the third sentence of
the paragraph below
the list of trips.

Press (Delete).

Your screen should be similar
to Figure 1.25

Additional Information

Review the Undo feature in the
“Undoing Editing Changes”section
on page 10.43 of the Introduction to
Microsoft Office 2010.

Another Method

The keyboard shortcut for the Undo
command is +Z.

-~
T Sentence deleted

Junk text deleted

Figure 1.25

The selected junk text and the complete sentence were removed from the flyer.

UNDOING EDITING CHANGES

After removing the sentence, you decide it may be necessary after all. To
quickly restore this sentence, you can use Undo to reverse your last action
or command. Notice that the Undo button includes a drop-down list but-
ton. Clicking this button displays a list of the most recent actions that can be
reversed, with the most recent action at the top of the list. When you select an
action from the drop-down list, you also undo all actions above it in the list.
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Open the E Undo
drop-down list.

Deleted word Junk text
restored restored

©® Choose Delete Word. \

Sentence restored

Your screen should be similar
to Figure 1.26

Figure 1.26

The deleted sentence, junk characters, and the word “four” are restored. You
will restore two of your corrections and then save the changes you have made
to the document to a new file.

Redo restores last Undo action

lick|® | Redo 2 v

times.

New file name

Another Method
The keyboard shortcut is +V.

Open the File tab and
choose Save As.

Save the document
as Flyer1 to your
solution file location.

Your screen should be similar
to Figure 1.27

./

Using Redo reversed changes
made using Undo

Figure 1.27
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E Move the cursor to

the beginning of the
word “Four”.

I Press (Cir) + (Delete).

Click in the left
margin to select the
entire title line.

® From the Font group,
click Change
Case.

Your screen should be similar
to Figure 1.28

Additional Information

You also can use + to cycle
through and apply the different change
case options.

Repeatedly using the @ Undo or IEI Redo buttons performs the actions in
the list one by one. So that you can see what action will be performed, the but-
ton’s ScreenTips identify the action.

The new file name, Flyer1, is displayed in the window title bar. The original
document file, wd01_Flyer1 is unchanged.

CHANGING CASE

You also want to delete the word “Four” from the second line of the flyer title
and capitalize the first letter of each word. Although you could change the
case individually for the words, you can quickly change both using the Change
Case command in the Font group.

™

Capitalizes the first letter of
each word in the selection

Figure 1.28

The Change Case drop-down menu allows you to change the case of selected
words and sentences to the desired case without having to make the change
manually. You want both words in the title to be capitalized.
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Choose Capitalize
Each Word.

Click anywhere to

deselect the title line. )
First letters

L je— capitalized

Your screen should be similar
to Figure 1.29

Figure 1.29

The first letter of each word in the title is now capitalized and the highlight is
removed from the text.

_Copying and Moving Selections

After looking over the letter, you decide to add the company name in several
other locations and to change the order of the list of tours. To make these
changes quickly, you can copy and move selections.

USING COPY AND PASTE

You want to include the company name in the last paragraph of the letter.
_ Because the name has already been entered on the first line of the document,
gggmjggmﬁgﬂ%anﬂ m;’r‘]’g - you will copy the name instead of typing the name again. Before you copy the
Selections”section Oﬁypage 10.45 of tﬁe text, you will reveal formatting marks in your document to make sure you're

Introduction to Microsoft Office 2010. copying exactly what you want.

Additional Information

Copying and Moving Selections WD1.29
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? Inserts system Clipboard contents
Click [T ] Show/ |

Hide to display the v
formatting marks in
your document. \

® Select the text
“Adventure Travel
Tours” not including
the 9 paragraph
symbol at the end of
the line.

Copies selection to system Clipboard

® Click[ ] Show/Hide
to hide the formatting
marks again.

Copied selection
inserted in document

o click| | Copy in the
Clipboard group of

the Home tab.
® Move the cursor to T
the left of “1” in the
phone number (last Paste Options button
paragraph).

Figure 1.30

® Click |:| Paste in

the Clipboard group. The copied selection is inserted at the location you specified. The[ | Paste

Options button appears automatically whenever a selection is pasted. It is
Another Method used to control the format of the pasted item. By default, pasted items main-

The Copy keyboard shortcut tain the original formatting from the source.
is + C. The Paste keyboard
shortcut is +V.

Your screen should be similar
to Figure 1.30
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Click the[ |

Paste Options button.

Your screen should be similar
to Figure 1.31

B Paste Options menu

/

Keep Source Formatting button is selected by default

Figure 1.31

The following table describes the options on the Paste Options menu.

Keep Source Formatting I:, Pastes the item with the same formatting that it had in the source.
Merse Formattin Pastes the item, changing the formatting to match the surrounding
e < destination text.

Pastes text only (from a selection that is a combination of text and graphics).
e et Oally This option also strips formatting from the pasted text.

Set Default Paste Enables you to change the default paste formatting setting to another:
The selection was pasted using the same formatting it had in the source, which

is appropriate for this sentence. You will close the Paste Options menu with-
out changing the selection.
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Click outside the
menu to close it.

Additional Information

The Paste Options button will disappear
as soon as you begin to type.

Type at

Press (Spacebar].

Your screen should be similar to
Figure 1.32

? Select “we” (third

sentence, first
paragraph).

@ Right-click on the
selection and click
(] Keep Source
Formatting from the
context menu.

Another Method

You could simply have clicked [ |
Paste in the Clipboard group of the
Home tab to insert the Clipboard
contents again.

l Change “are” in the
same sentence to
“is"'

Your screen should be similar
to Figure 1.33

! T~

Source formatting maintained Paste Options button no longer appears

Figure 1.32

Next, you want to insert the company name in place of the word “we” in the
first paragraph and then change the word “are” to “is”.

Clipboard contents pasted again

/

Figure 1.33

The selected text was deleted and replaced with the contents of the system Clip-
board. The system Clipboard contents remain in the Clipboard until another
item is copied or cut, allowing you to paste the same item multiple times.
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Select the line of text
“Costa Rica Rivers
and Rainforests”.

Having Trouble?

Click in the margin space to the left of
the paragraph to select it.

Click . Cut in the
Clipboard group.

Another Method

The Cut keyboard shortcut is +X.
You also can choose Cut from the
context menu.

Move to the “I” in the
“Inca Trail to Machu
Picchu” title.

Press +V.

Your screen should be similar
to Figure 1.34

Additional Information

Review the drag and drop feature in the
“Using Drag and Drop”section on page
10.49 of the Introduction to Microsoft
Office 2010.

Additional Information

You also can use drag and drop to copy
a selection by holding down while
dragging. The mouse pointer shape

iSi‘a‘,.

USING CUT AND PASTE

You've decided to move the “Costa Rica Rivers and Rainforests” tour name to
be second in the tour list. To do this, you will move the name from its current
location to the new location. The Cut and Paste commands in the Clipboard
group of the Home tab are used to move selections.

Cut text copied from system
Clipboard and inserted in document

Figure 1.34

The selected text was removed from the source and copied to the Clipboard.
Then it was reentered into the document at the cursor location. That was
much quicker than retyping the tour name over!

USING DRAG AND DROP

Finally, you also decide to move the tour name “Safari in Tanzania” to first in
the list. Rather than use Cut and Paste to move this text, you will use the drag-
and-drop editing feature. This feature is most useful for copying or moving
short distances in a document.
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E Select the entire line

“Safari in Tanzania”,
including the space
at the end of the line.

©® Drag the selection to
the left of the “India
Wildlife Adventure”
tour name.

® Click @ Save in the

Quick Access Toolbar
to save the file using
the same file name.

Additional Information

You also can move or copy a selection
by holding down the right mouse button
while dragging.

When you release the mouse
button, a context menu appears with the
available move and copy options.

Your screen should be similar
to Figure 1.35

Additional Information

Refer to the section “Formatting Text”
on page 10.4 in the Introduction to
Microsoft Office 2010 to review font
and font size.

Selection
moved using
drag and drop

Figure 1.35

The selection is moved to the new location. As you are working on a docu-
ment, it is a good idea to save your document frequently to prevent the acci-
dental loss of work from a power outage or other mishap. While AutoRecover
is a great feature for recovering lost work, it should not be used in place of
regularly saving your work.

_Formatting a Document

Because this document is a flyer, you want it to be interesting to look at and
easy to read. Applying different formatting to characters and paragraphs can
greatly enhance the appearance of the document. Character formatting
consists of formatting features that affect the selected characters only. This
includes changing the character style and size, applying effects such as bold
and italics to characters, changing the character spacing, and adding ani-
mated text effects. Paragraph formatting features affect an entire paragraph. A
paragraph consists of all text up to and including the paragraph mark. Para-
graph formatting features include how the paragraph is positioned or aligned
between the margins, paragraph indentation, spacing above and below a para-
graph, and line spacing within a paragraph.

CHANGING FONTS AND FONT SIZES

The first formatting change you want to make is to use different fonts and
font sizes in the flyer. Using fonts as a design element can add interest to your
document and give readers visual cues to help them find information quickly.
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Two basic types of fonts are serif and sans serif. Serif fonts have a flair
at the base of each letter that visually leads the reader to the next letter. Two
common serif fonts are Roman and Times New Roman. Sans serif fonts don’t
have a flair at the base of each letter and are generally used for text in para-
graphs. Arial and Calibri are two common sans serif fonts. Because sans serif
fonts have a clean look, they are often used for headings in documents. A good
practice is to use only two types of fonts in a document, one for text and one
for headings. Using too many different font styles can make your document
look cluttered and unprofessional.

Several common fonts in different sizes are shown in the table below.

Arial Sans serif This is 10 pt.

This is 16 pt.
Courier New Serif This is 10 pt.

This is 16 pt.
Times New Roman Serif This is 10 pt.

This is 16 pt.

To change the font before typing the text, use the command and then type. All
text will appear in the specified setting until another font setting is selected. To
change a font setting for existing text, select the text you want to change and
then use the command. If you want to apply font formatting to a word, simply
move the cursor to the word and the formatting is automatically applied to the
entire word.

First you want to increase the font size of all the text in the flyer to make
it easier to read. Currently, you can see from the Font Size button in the Font
group that the font size is 11 points.

/ Current font
Triple-click in the
left margin when the /
mouse pointer is 7! =4
to select the entire
Current
document. font size Click the down arrow to display

the Font Size drop-down list

Another Method
The keyboard shortcut is +A.

l From the Font group,

open the Font

Size drop-down list.

Another Method

The keyboard shortcut
is + +P.

Your screen should be similar

to Figure 1.36 Figure 1.36
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Refer to the Section

“Formatting Text” on page 10.40 in the
Introduction to Microsoft Office 2010 to
review the Live Preview feature.

Point to several
different point sizes
in the list to see the
Live Preview.

Click 14 to choose it.

Your screen should be similar
to Figure 1.37

Additional Information

If a selection includes text of various
sizes, the Font Size button will be blank.

The current (default) font size of 11 is selected. You will increase the font
size to 14 points. As you point to the size options, the Live Preview feature
shows how the selected text in the document will appear if chosen.

New font size

Figure 1.37

The font size of all text in the document has increased to 14 points, making
the text much easier to read. The Font Size button displays the new point size
setting for the text at the location of the cursor.

Next you will change the font and size of the two title lines. First you will
change the font to Comic Sans MS and then you will increase the font size.
Many of the formatting commands are on the Mini toolbar that appears when-
ever you select text.
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? New font applied
Select the two title / \

lines and point to the /

Mini toolbar.

® Openthe[ |

Font drop-down
menu in the Mini
toolbar.

et

Mini toolbar

® Scroll the list and
choose Comic Sans
MS.

Additional Information

Font names are listed in alphabetical
order.

Having Trouble?

If this font is not available on your
computer, choose a similar font.

Your screen should be similar Figure 1.38

to Figure 1.38

Using the Mini toolbar to apply the formats is a quick and convenient alterna-
tive to using the Ribbon. Next, you will change the font size.

Open the
Font Size drop-down
menu in the Mini New font size

toolbar.

Choose 36. / \

Your screen should be similar
to Figure 1.39

Figure 1.39
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The selected font and size have been applied to the selection, making the title
lines much more interesting and eye-catching. The Font and Font Size buttons
reflect the settings in use in the selection. As you look at the title lines, you decide
the font size of the first title line is too large. You will reduce it to 20 points.

Select the first title \

line. New font size

Click and e \

choose 20 points
Font Size drop-down
menu.

Your screen should be similar
to Figure 1.40

Figure 1.40

Finally, you want to change the font of the list of four tours.

? Select the list of four

tours.

® Click[ ]

Font in the Mini
toolbar and change
the font to Comic
Sans MS.

Additional Information
Theme fonts and recently used fonts :|<— New font

appear at the top of the list. You will
learn about themes in Lab 3.

Click anywhere on
the highlighted text
to deselect it.

Reduce the zoom so
the entire page is
visible.

Figure 1.41

Your screen should be similar
to Figure 1.41
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The changes you have made to the font and font size have made the flyer some-
what more interesting. However, you want to further enhance the document.

APPLYING CHARACTER EFFECTS

Next you want to liven up the flyer by adding character effects such as color
and bold to selected areas. The table below describes some of the effects and

their uses.

Bold, italic
Underline
Strikethrough
Double strikethrough
Superscript
Subscript
Shadow
Outline
Emboss
Engrave
Small caps
All caps
Hidden

Color

Bold [talic
Underline
s
bl e b
“To be or not to be.”!
H,0

Shadow

Outline

Firnboss

Engrave

SMALL CAPS

ALL CAPS

Color Color Color

Adds emphasis.

Adds emphasis.

Indicates words to be deleted.

Indicates words to be deleted.

Used in footnotes and formulas.

Used in formulas.

Adds distinction to titles and headings.
Adds distinction to titles and headings.
Adds distinction to titles and headings.
Adds distinction to titles and headings.
Adds emphasis when case is not important.
Adds emphasis when case is not important.

Prevents selected text from displaying or printing.
Hidden text can be viewed by displaying formatting
marks.

Adds interest

First you will add color and bold to the top title line. The default font color
setting is Automatic. This setting automatically determines when to use black
or white text. Black text is used on a light background and white text on a dark

background.
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? Color and bold applied to text
Return the zoom to N

100%. / \

® Select the first title
line and point to the
Mini toolbar.

® Open the Font
Color drop-down list

on the Mini toolbar.

® Choose @ Orange
from the Standard
Colors bar.

Figure 1.42

Additional Information

A ScreenTip displays the name of the
color when selected. The buttons reflect the settings associated with the text at the insertion point.
The Font Color button appears in the last selected color. This color can be

quickly applied to other selections now simply by clicking the button.
Click [ B | Bold on the

Mini toolbar.

Another Method
The keyboard shortcut is +B.

l Click on the title line
to clear the selection.

Your screen should be similar
to Figure 1.42
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? Select the second

title line.

® Using the Mini
toolbar, change the
font color to green
using the Standard
Colors bar.

® Add bold to the
selected title.

® Select the list of four
tours.

@ Click [2A] Font Color
to change the color to
green.

Additional Information

The currently selected font color can
be applied to the selection simply by
clicking the button.

Click | B | Bold,

Italic.

Click Italic again
to remove the italic
effect.

Additional Information

Many formatting commands are toggle
commands. This means the feature can
be turned on and off simply by clicking
on the command button.

Apply bold, italic, and
orange font color to
the last sentence of
the flyer.

Click in the document
to deselect the text.

Your screen should be similar
to Figure 1.43

Next you will add color and bold to several other areas of the flyer.

Color and bold effect added to text

I
Color, bold, and italic effect added to text

Figure 1.43

The character formatting effects you added to the flyer make it much more
interesting.
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Select both title lines.

click 2] in the
bottom-right corner
of the Font group to
open the Font dialog
box.

Your screen should be similar
to Figure 1.44

The next formatting change you want to make is to apply the Small Caps
effect to the title lines. Since the Ribbon does not display a button for this fea-
ture, you need to open the Font dialog box to access this feature.

Current font and style

/\

Preview box
—_—
displays example of

current selections /

Font description

Figure 1.44

The Font dialog box contains all of the Font commands in the Font group
and more. Using the Dialog Box Launcher to open a dialog box allows you to
access the more-advanced or less-used features of a group. The font and font
style used in the selected text are identified in the list boxes. However, because
the selection includes two different font sizes and colors, these settings are not
identified.

The Preview box displays an example of the currently selected font setting.
Notice the description of the font below the Preview box. It states that the
selected font is a TrueType font. TrueType fonts are fonts that are automati-
cally installed when you install Windows. They appear onscreen exactly as
they will appear when printed. Some fonts are printer fonts, which are avail-
able only on your printer and may look different onscreen than when printed.
Courier is an example of a printer font.
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You will add the Small caps effect to the selected lines.

Choose Small caps.

Click[ .

Small Caps effect

. applied to selection
Your screen should be similar 4/'/ PP

to Figure 1.45

Figure 1.45

The Small caps effect has been applied to all text in the selection and adds
more emphasis to the title lines.

SETTING PARAGRAPH ALIGNMENT

The final formatting change you want to make is to change the paragraph
alignment.
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Co “CBpt a Alignment

Alignment is the positioning of text on a line between the margins or indents. There are four types of paragraph
alignment: left, centered, right, and justified. The alignment settings affect entire paragraphs and are described
in the table below.

Left Aligns text against the left margin of the page, leaving the right margin
ragged or uneven. This is the most commonly used paragraph align-
ment type, and therefore the default setting in all word processing
software packages.

Center Centers cach line of text between the left and right margins. Center
alignment is used mostly for headings or centering graphics on a page.

Right Aligns text against the right margin, leaving the left margin ragged. Use
right alignment when you want text to line up on the outside of a page,
such as a chapter title or a header.

Justify Aligns text against the right and left margins and evenly spaces out
the words by inserting extra spaces, called soft spaces, that adjust
automatically whenever additions or deletions are made to the text.
Newspapers commonly use justified alignment so the columns of text
are even.

The commands to change paragraph alignment are available in the Paragraph
dialog box. However, it is much faster to use the keyboard shortcuts or com-
mand buttons in the Paragraph group shown below.

Left N
Center +E
Right +R
Justify 0
WbD1.44 Lab 1: Creating and Editing a Document WWW.MHHE.COM/OLEARY

Word 2010



The O'Leary Series: Microsoft® Office 2010: A Case Approach, Introductory

You want to change the alignment of all paragraphs in the flyer from the
default of left-aligned to centered.

Text centered

Triple-click in the left
margin to select the
entire document.

Click = Center in

the Mini toolbar.

Another Method

You also can use in the Paragraph
group of the Home tab or choose
Centered from the Alignment list box

in the Paragraph dialog box.

i Reduce the zoom so
the entire page is
visible.

Your screen should be similar
to Figure 1.46

Figure 1.46

Each line of text is centered evenly between the left and right page margins.

Additional Information CLEARING FORMATS

The alignment sattings also can be As' you look at the entire fl'ye}r, you deci'de the le}st ;ine is overform'atted.. You
specified before typing in new text. As think it would look better if it did not include italics and color. Since it has
you type, the text is aligned according been a while since you applied these formats, using Undo also would remove
to your selection until the alignment . .

setting is changed to another setting. many other changes that you want to keep. Instead, you will quickly clear all

formatting from the selection and then apply only those you want.
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Increase the zoom to
100%.

Additional Information
In addition to using the Zoom slider,

you can click in the Zoom group

of the View tab.

Select the last
sentence.

Click Clear

Formatting in the
Font group.

Your screen should be similar
to Figure 1.47

Another Method

Instead of clearing all formats, you
could simply reselect the command
button to remove the formats that you
did not want or select another format to
replace it.

Clears all formatting from selection

i

N

All formats cleared

Figure 1.47

All formatting associated with the selection, including text alignment and
font size, has been removed and the text appears in the default document
font and size.

Format the last sentence to bold, centered, and a font size of 14.

Click IEI Save in the Quick Access Toolbar to save the file using the same file name.

The formatting of the last sentence looks much better now.
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Working with Graphics

Finally, you want to add a graphic to the flyer to add interest.

CO Ilcepl u Graphics

A graphic is a nontext element or object such as a drawing or picture that can be added to a document. An
object is an item that can be sized, moved, and manipulated.

A graphic can be a simple drawing object consisting of shapes such as lines and boxes. A drawing object is
part of your Word document. A picture is an illustration such as a graphic illustration or a scanned photograph.
Pictures are graphics that were created using another program and are inserted in your Word document as
embedded objects. An embedded object becomes part of the Word document and can be opened and edited
from within the Word document using the source program, the program in which it was created. Any changes
made to the embedded object are not made to the original picture file because they are independent. Several
examples of drawing objects and pictures are shown below.

Drawing object Graphic illustration Photograph

Add graphics to your documents to help the reader understand concepts, to add interest, and to make your
document stand out from others.

Pictures can be obtained from a variety of sources. Many simple drawings
called clip art are available in the Clip Organizer, a Microsoft Office tool that
arranges and catalogs clip art and other media files stored on the computer’s
hard disk. Additionally, you can access Microsoft’s Clip Art and Media Web
site for even more graphics.

Digital images created using a digital camera are one of the most common
types of graphic files. You also can create picture files using a scanner to con-
You also can scan a picture and insertit  vert any printed document, including photographs, to an electronic format.
R ord document without Most images that are scanned and inserted into documents are stored as Win-
saving it as a file first. . X . . . .

dows bitmap files (.bmp). All types of pictures, including clip art, photographs,
and other types of images, can be found on the Internet. These files are com-
monly stored as .jpg or .pcx files. Keep in mind that any images you locate on
the Internet may be copyrighted and should only be used with permission.
You also can purchase CDs containing graphics for your use.

Additional Information
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? Move to the blank

line below the second
title line.

I Open the Insert tab.

From the lllustrations

group, click |:|

® Select the location
containing your data
files.

I Select wd0O1_Lion.

click[ |

Your screen should be similar
to Figure 1.48

Additional Information

You will learn more about the Picture
Tools tab features in later labs.

INSERTING A PICTURE FROM FILES

You want to add a picture to the flyer below the two title lines. You will move
to the location in the document where you want to insert a photograph of a
lion you recently received from a client. The photograph has been saved as a
picture image.

Tab contains commands to modify picture objects

4

Sizing handle —>» Selected picture

<— inserted and centered

in document
Selection

rectangle

Figure 1.48

The picture is inserted in the document at the location of the cursor. It is cen-
tered because the paragraph in which it was placed is centered. Notice the pic-
ture is surrounded by a selection rectangle and four circles and four squares,
called sizing handles, indicating it is a selected object and can now be deleted,
sized, moved, or modified. A Picture Tools tab automatically appears and can
be used to modify the selected picture object.
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INSERTING A PICTURE FROM CLIP ART

Although you like the picture of the lions that you might see on one of the
tours, you want to check the Clip Art Gallery to see if you can locate a better
animal picture.

Clip Art task pane

Click to the right
side of the graphic to
deselect it.

Open the Insert tab.

i Enter descriptive word
From the lllustrations

[
—>
group, click s Select types of
files to locate

Your screen should be similar
to Figure 1.49

Access graphics on the
Office.com Web site

Figure 1.49

The Clip Art task pane appears in which you can enter a word or phrase that
is representative of the type of picture you want to locate. You also can specify
the locations to search and the type of media files, such as clip art, movies,
photographs, or sound, to display in the results. You want to find clip art and
photographs of animals.
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? If necessary, select

any existing text in
the Search For text
box.

Type animals

If necessary, select
the Include Office.
com content check
box.

Having Trouble?

Click the box next to an option to select
or deselect (clear the checkmark).

:

Open the Results
Should Be drop-
down list, select
Illustrations and
Photographs, and
deselect all other
options.

Click | 80 |

Your screen should be similar
to Figure 1.50

Having Trouble?

Your Clip Art task pane may display
different pictures than shown in
Figure 1.50.

WD1.50

Word 2010

Search for “animals”

Thumbnails of
photographs and clip —|
art of animals

Figure 1.50

The program searches the Microsoft Clip Organizer on your computer and, if
you have an Internet connection established, Microsoft’s Office Online site for
clip art and graphics that match your search term. The Results area displays
thumbnails, miniature representations of pictures, of all located graphics.
The pictures stored in the Microsoft Clip Organizer appear first in the results
list, followed by the Office Online clip art.

Pointing to a thumbnail displays a ScreenTip containing the keywords asso-
ciated with the picture and information about the picture properties. It also
displays a drop-down list bar that accesses the item’s context menu.
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Scroll the list to view
additional images.

Point to any
thumbnail to see a
ScreenTip.

Your screen should be similar
to Figure 1.51

Access selected

item’s context menu \

ScreenTip \

Figure 1.51

Each graphic has several keywords associated with it. All the displayed graph-
ics include the keyword “animals.” Because so many pictures were located,
you decide to narrow your search to display pictures with keywords of “ani-
mals” and “parrots” only. Additionally, because it is sometimes difficult to see
the graphic, you can preview it in a larger size.
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? Preview/Properties dialog box provides more
information about selected graphic i
Add a comma and grap Close Clip Art task pane

a space after the
word “animals” in
the Search For text
box and then type
parrots

I Click[_Go_].

Scroll the results
area, if necessary,
and point to the
graphic of the parrot
shown in Figure 1.52.

® Click [™| next to the

graphic to open the
context menu.

® Choose Preview/

Properties.
Figure 1.52
Additional Information Because the search term is more specific, fewer results are displayed. The
If you cannot find the picture of the Preview/Properties dialog box displays the selected graphic larger so it is eas-
parrot shown in Figure 1.52, it is ier to see. It also displays more information about the properties associated

Reatieduitfiéles downloadad for with the graphic, including the keywords used to identify the graphic. You
the lab as wd01_Parrot. Use |:|

think this looks like a good choice and will insert it into the document.

to insert it into the flyer.

Your screen should be similar
to Figure 1.52
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Click]  Jto
close the dialog box.

Click on the graphic
to insert it in the
document.

Another Method

You also could choose Insert from the
thumbnail’s context menu.

Second
graphic is
Click| _|in the Clip i redin
Art task pane title bar document
to close it.
Scroll the document,
if necessary, to view
the pictures in their
entirety.
Figure 1.53
Your screen should be similar The clip art graphic is inserted next to the lion picture. You will reduce the size
to Figure 1.53 of the clip art graphic shortly.

DELETING A GRAPHIC

There are now two graphics in the flyer. You decide to use the parrot graphic
and need to remove the picture of the lion. To do this, you select the graphic
and delete it.

Click on the lion
graphic to select it.

Press (Delete].

Your screen should be similar
to Figure 1.54

Picture of lion
deleted

Figure 1.54

The lion graphic is removed and the parrot graphic is centered on the page.
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Additional Information

A selected graphic object can be moved
by dragging it to the new location.

Another Method

You also can size a picture to an exact
measurement using commands in the
Size group of the Picture Tools tab.

Click on the graphic
to select it.

Point to the lower-
right corner handle.

Additional Information

Dragging a corner handle maintains the
original proportions of the graphic.

;

With the pointer as

a ®,, drag inward to
decrease the size to
approximately 1.25
inches wide by 2
inches high (use the
ruler as a guide and
refer to Figure 1.55).

Click anywhere in the
document to deselect
the graphic.

Reduce the zoom to
display the entire
page.

Your screen should be similar
to Figure 1.55

WD1.54

Word 2010
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SIZING A GRAPHIC

Usually, when a graphic is inserted, its size will need to be adjusted. A graphic
object can be manipulated in many ways. You can change its size; add cap-
tions, borders, or shading; or move it to another location. A graphic object
can be moved anywhere on the page, including in the margins or on top of or
below other objects, including text. The only places you cannot place a graphic
object are into a footnote, endnote, or caption.

In this case, you want to decrease the picture’s size. To size a graphic, you
select it and drag the sizing handles to increase or decrease the size of the
object. The mouse pointer changes to ™, when pointing to a handle. The
direction of the arrow indicates the direction in which you can drag to size
the graphic. You want to increase the image to approximately 1 inch wide by
1.5 inches high.

<« Picture decreased in size

Figure 1.55

ADDING A WATERMARK

The final change you want to make to the flyer for now is to add a watermark
in the page background. Watermarks are text or pictures that appear behind
document text. They often add interest or identify the document status, such
as marking a document as a Draft. You can insert a predesigned watermark
from a gallery of watermark text, or you can insert a watermark with custom
text. The watermark feature affects an entire page and is found in the Page
Layout tab.

You have decided to add a watermark to the background of the flyer identi-
fying the document as a draft.

WWW.MHHE.COM/OLEARY
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? Open the Page Layout

tab.

® Click [ Watermark ~

from the Page
Background group.

® Scroll the Watermark
gallery and choose
the Draft 1 design
from the Disclaimers
section.

® Click IEI Save.

Your screen should be similar
to Figure 1.56

Additional Information

You can only see watermarks in Print
Layout view and Full Screen Reading
view or in a printed document.

Additional Information
Choose Remove Watermark from the
A Watermark ~ | meny o remove a

watermark.

Opens Watermark gallery

/

/

Draft 1 watermark design
added to page background

Figure 1.56

The DRAFT watermark appears diagonally across the background of the page.
The entire page is displayed as it will appear when printed. The flyer looks
good and does not appear to need any further modifications immediately.
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Increase the zoom to
100%.

Press +

and then press

(Spacebar].

Type Your Name
will gladly help
with all of your
questions. as the
last sentence of the
flyer.

Your screen should be similar
to Figure 1.57

Having Trouble?

If your document now extends beyond
a single page, reduce the size of the
graphic slightly. If resizing the graphic
does not work, check for and delete
any extra blank lines at the end of the
document.

Additional Information

Review document properties in the
“Specifying Document Properties”
section on page 10.51 of the Introduction
to Microsoft Office 2010.

MODIFYING DOCUMENT PROPERTIES

Before printing the document for your manager, you will add a sentence to the
flyer that includes your name and edit the document properties.

N

Inserted sentence

Figure 1.57

Next, you will look at the document properties that are automatically
included with the Flyer1 file. You also will add documentation to identify
you as the author, and specify a document title and keywords to describe the
document.
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? Open the File tab

and then click the
Show All Properties
link below the list of
properties.

® Enter New Tours
Flyer in the Title
text box.

@ Enter Flyer in the
Tags text box.

@ Enter First Draft
as the Status.

@ Enter Advertising
as the category.

@ Enter Four new
tours as the
Subject.

@ Type your name
in the Author text
box.

Your screen should be similar
to Figure 1.58

Additional Information

Review previewing and printing in the
“Printing a Document” section on page
10.56 of the Introduction to Microsoft
Office 2010.

File properties in /

expanded view

You are now finished entering document properties.

Printing a Document

Figure 1.58

Although you still plan to make several formatting changes to the document,
you want to give a copy of the flyer to your manager to get feedback regarding

its content and layout.

PREVIEWING THE DOCUMENT

As part of the printing process, Word automatically displays a preview image
of your document, showing you exactly how the document will appear when

printed.

Printing a Document

WD1.57
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If necessary, make
sure your printer is

on and ready to print. /

Choose Print on the

File tab. (| Document
preview

Currently selected printer

Your screen should be similar
to Figure 1.59

Figure 1.59

A preview image of your document displays on the right side of your screen.
This image of the flyer should be similar to the document shown in the Case
Study at the beginning of the lab.

NOTE Please consult your instructor for printing procedures that may differ from the following
directions.

You will now print the document using the default print settings.

If you need to change the selected printer to another printer, open the Printer drop-down list box and select the
appropriate printer (your instructor will tell you which printer to select).

Click

Your printer should be printing the document.
You are finished working on the flyer for now and want to save the proper-
ties you entered.

Click @ Save.

Openthe Filetaband click] |,

The flyer is saved and the document window is empty.
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Working with Templates

You would like to give a copy of the completed flyer to your manager Maria
Salverez for feedback along with a cover memo. You will begin by creating a
memo using one of the document templates included in Word.

Co ncept a Templates

A template is a document file that stores predefined settings and other elements such as graphics for use as
a pattern when creating documents. The Normal document template automatically opens whenever you start
Word 2010. Settings such as a Calibri 11-point font, left-alignment, and 1-inch margin are included in the Nor-
mal template. So far, you have only used the Normal document template as a basis for your documents.

In addition to this template, Word also includes many other templates that are designed specifically to help
you create professional-looking business documents such as letters, faxes, reports, brochures, press releases,
manuals, newsletters, resumes, invoices, purchase orders, and Web pages. Many of the templates are already
installed and are available within Word. Many more are available at the Microsoft Office Online Templates Web
page. The settings included in these specialized templates are available only to documents based on that tem-
plate. You also can design and save your own document templates.

All template files have a .dotx file extension and are stored in the Templates folder. The Normal document
template, for example, is named Normal.dotx. When you create a new document from a template file, a copy of
the file is opened and the file type changes to a Word document (.docx). This prevents accidentally overwriting
the template file when the file is saved.

You will now start a new document using one of Word’s memo templates. This
template file is available at the Microsoft Office.com Web site. You will then
change different elements in the template to give it your own personal style.

N Currently selected template (based on Normal.dotx)
g Open the File tab

and choose New to
display the available
templates.

Your screen should be similar

to Figure 1.60

Having Trouble? T

If you do not have access to Office Preview
Online, no templates will display in the of selected

Office.com Templates area. If this is your
situation, open the file wd01_Elegant
Memo from your data files location.

template

\ Template categories at

Microsoft Office Online Web site

Figure 1.60
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From the Office.com
Templates section,
choose Memos.

Select the Memo
(Elegant design)
template.

Your screen should be similar
to Figure 1.61

Click I:'

Change the zoom to
page width.

Your screen should be similar
to Figure 1.62

WD1.60
Word 2010

The templates are categorized by topic. You will look in the Memo category to
find a template to use for your memo to the manager.

Current template category

-
Description of
selected template/v
<« Preview of selected

template

Copies template
to your computer

Figure 1.61

Word displays a gallery of memo templates in different designs and the Preview
area displays how the selected template looks. You will use the Memo (Elegant
design) template to create your memo. Because this template is stored on the
Office Online Web site, you need to download it to your computer. It will then
open automatically for you in Word.

New document based on the
Memo (Elegant design) template

Placeholders

Lab 1: Creating and Editing a Document

Figure 1.62
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A copy of the memo template is opened as a new Word document and is dis-
played in Print Layout view. The file name “Document2” appears in the Title

During a Word session as new PN . )

documents are opened. they are named bar, indicating that the current document hasn'’t yet been saved. The templat.e

Document followed by a sequential itself, however, is saved to your computer so that you can open and use it

number. again without having to download it again.

Additional Information

REPLACING PLACEHOLDERS

Templates often include placeholders, which are graphic elements, com-
monly enclosed in brackets, that are designed to contain specific types of
information. You edit placeholders to contain the information you want by
clicking on the placeholder to select it and then typing the new information.

You will modify the memo header, which includes placeholders for identify-
ing the recipient, sender, subject, date and a “CC:” (carbon or courtesy copy)
recipient.

? Click the To:

placeholder.

® Type Maria
Salverez

® Click the From:
placeholder and type
yO ur name Replaced placeholders
. . automatically formatted
L gllla(::keltl'(])?dselrl':j:gt with all capital letters
type Adventure

Travel Tours
Flyer

Your screen should be similar
to Figure 1.63

Figure 1.63

As a result of formatting selections stored in the memo template, the text you
typed was automatically formatted in all capital letters. After you type text
into a placeholder, the placeholder usually changes into normal text. This is
true of all the placeholders in the Memo (Elegant design) template.

The computer’s system date was automatically inserted in the Date: place-
holder. As a result, the current date might not be displaying in the memo. You
have decided not to use the CC: placeholder, so you will delete it and its iden-
tifying text.
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? If the date displaying

in the Date:
placeholder isn’t

the current date,
double-click on the
placeholder and type
in the correct date.

® Click the GC: Template
placeholder and then instructions will be

press (Delete). deleted and replaced

with typed text

® Select the text “GC:” <«——  CC: placeholder deleted
and then press

(Delete].

Your screen should be similar
to Figure 1.64

Figure 1.64

ENTERING BODY TEXT

Next you will type a few sentences into the body of the memo. The template
currently includes a title and some instructions on how to use the memo tem-
plate. You will select this text and replace it with your own.

Select the title and
following paragraph
located below the
last horizontal line.

Type Maria,
please review
the draft of the
flyer | created
announcing
our new travel
adventures.

| look forward
to receiving
your feedback.

Thanks! \

Typed body text replaced

Your screen should be similar template instructions

to Figure 1.65

Figure 1.65
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The text you typed replaced the selected text. The memo is now complete. You
want to save it and exit the Word application.

‘Exiting Word

The |:| command in the File menu or the Exit button in the appli-

cation window title bar are used to quit the Word program. If you attempt to
28‘1’?";’[)"")’;:223(:2,}22c“t'iz‘;‘ri]tigg ::ggflfg’gf’ exit the application without first saving your document, Word displays a warn-
of the Introduction to Microsoft Office ing asking if you want to save your work. If you do not save your work and you
2010. exit the application, any changes you made since last saving it are lost.

Additional Information

Open the File tab and click |:|

Click |:| and select your solution file location.

In the File name text box, change the proposed file name to Flyer Memo.

click| |

The memo is saved as Flyer Memo.docx to the location you selected, the
document is closed and the application exited. The original template file is
unchanged on your computer so you can use it again to create another memo.

R,
) FOCUS ON CAREERS

EXPLORE YOUR CAREER OPTIONS increasingly involve administrative tasks, including recruiting
new employees. As a food service manager, your position
Food Service Manager would likely include creating newspaper notices and flyers

Have you noticed flyers around your campus advertising job to attract new staff. These flyers should be eye-catching and
positions? Many of these jobs are in the food service industry.  error-free. The typical salary range of a food service manager
Food service managers are traditionally responsible for over- s $34,000 to $41,700. Demand for skilled food service man-
seeing the kitchen and dining room. However, these positions agers is expected to increase through 2012.

Exiting Word WD1.63
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I
' ah 1 CONCEPT SUMMARY  creating anc ctting  ocument
I

Grammar Checker (WD1.12)

The grammar checker advises you
of incorrect grammar as you create
and edit a document, and proposes
possible corrections.

Grammar Checker
«
Spelling Checker (WD1.14)

The spelling checker advises you
of misspelled words as you create
and edit a document, and proposes
possible corrections.

<« Spelling Checker

AutoCorrect (WD1.16)

The AutoCorrect feature makes
some basic assumptions about the
text you are typing and, based on
these assumptions, automatically
corrects the entry.

AutoCorrect

P
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Word Wrap (WD1.19)

The word wrap feature
automatically decides where to end
a line and wraps text to the next
line based on the margin settings.

Word Wrap

i

Alignment (WD1.44)

Alignment is the positioning of text
on a line between the margins or
indents. There are four types of
paragraph alignment: left, centered,
right, and justified.

Fonts and Font Size

| S |

Graphics (WD1.47)

Alignment
A graphic is a nontext element or

object such as a drawing or picture

that can be added to a document. [

Graphics

T

Templates (WD1.59)

A template is a document file that
stores predefined settings and
other elements such as graphics
for use as a pattern when creating
documents.

Template

M
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KEY TERMS

alignment WD1.44 Normal document template WD1.59
AutoCorrect WD1.16 object WD1.47
character formatting WD1.34 paragraph formatting WD1.34
clip art WD1.47 picture WD1.47
cursor WD1.5 placeholder WD1.61
custom dictionary WD1.14 ruler WD1.5
default WD1.7 sans serif font WD1.35
document window WD1.5 selection rectangle WD1.48
drawing object WD1.47 serif font WD1.35
edit WD1.4 sizing handles WD1.48
embedded object WD1.47 soft space WD1.44
end-of-file marker WD1.8 source program WD1.47
format WD1.4 spelling checker WD1.14
grammar checker WD1.12 template WD1.59
graphic WD1.47 thumbnail WD1.50
Insert mode WD1.23 TrueType WD1.42
insertion point WD1.5 watermark WD1.54
main dictionary WD1.14 word wrap WD1.19
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COMMAND SUMMARY

IE Save +S Saves document using same file name

Undo +Z Restores last editing change

Redo +Y Restores last Undo or repeats last command or action
New +N Opens new blank document or specialized template

+0 Opens existing document file

|:| +S Saves document using same file name

F12 Saves document using a new file name, type, and/or location
Print +P Prints document
|:| Change options for working with Word
I:l + Closes document
|:| + Exit Word application
(Hometab | [ |
Clipboard group
|:| Copy +C Copies selection to Clipboard
Cut +X Cuts selection to Clipboard
I:I Paste +V Pastes items from Clipboard
Font group

[ ]Font Changes typeface
Font Size Changes font size

Clear Formatting Removes all formatting from selection
o Cirl) + s/removes bold effect
Bold Cr) +B Adds/ bold effi
Ttalic +1 Adds/removes italic effect
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COMMAND SUMMARY (CONTINUED)

Change Case + Changes case of selected text

Font Color Changes text to selected color

Paragraph group

Show/Hide +* Displays or hides formatting marks

Align Text Left +L Aligns text to left margin

Center +E Centers text between left and right margins

Align Text Right +R Aligns text to right margin

Justifly +7J Aligns text equally between left and right margins

S I

Ilustrations group

Inserts selected picture

Accesses Clip Organizer and inserts selected clip

Page Layout Tab T

Page Background group

Al Watermark = Inserts watermark behind page content
Review?tb | |

Proofing group

Opens Spelling and Grammar dialog box

Vewtp | |

Document Views group

Shows how text and objects will appear on printed page
Displays document only, without application features
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COMMAND SUMMARY (CONTINUED)

Shows document as it will appear when viewed in a Web browser
Shows structure of document
Shows text formatting and simple layout of page

Show group
i Displays/hides ruler

Zoom group

Opens Zoom dialog box

Zooms document to 100% of normal size

A_l One Page Zooms document so an entire page fits in window

Zooms document so width of page matches width of window

H
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SCREEN [DENTIFICATION

1. In the following Word screen, letters identify important elements. Enter the correct term for each
screen element in the space provided.

o oclole
7
/

A
-

< ™
-
T

N

Possible answers for the screen identification are:
Spelling and Grammar Font color A. L.

status icon Show/Hide B. M.
Scroll bar Center C. N.
Bold Scrolls down D. 0.
Graphic Redo E. P.
Save Tab mark F. Q.
Ruler Status bar G. R.
Close Draft view H. S.
Font Ribbon I
Undo Paragraph Mark J.
Zoom Print Layout view K.
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MATCHING

Match the item on the left with the correct description on the right.

1. word wrap ____ a. undoes last command
2. [5] ____ b. moves to the top of the document
3. @ ____ c. feature that automatically begins a new line when text
reaches the right margin
4. alignment ____ d. simplifies the creation of new documents
5. ____e. shows dialog box
6. sans serif ____ f. type style that can be applied to text
7. template ____ g. font size measurement
8. point ____ h. controls paragraph positioning between the margins
9. font ____i. saves a document using the same file name
10. + ____j. font without a flair at the base of each letter

TRUE/FALSE

Circle the correct answer to the following questions.
1. The AutoCorrect feature automatically identifies and corrects certain types of errors. True  False

2. The automatic word wrap feature checks for typing errors. True False
3. Font sizes are measured in inches. True False
4. A wavy red line indicates a potential spelling error. True False
5. The default document settings are stored in the Normal.docx file. True False
6. A selected picture is surrounded by a selection rectangle and eight moving handles.  True  False
7. The key erases the character to the right of the cursor. True False
8. The Word document file name extension is .wrd. True False
9. Word inserts hidden marks into a document to control the display of text. True False
10. Hard spaces are used to justify text on a line. True False
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FILL-IN

Complete the following statements by filling in the blanks with the correct terms.

1. To size a graphic evenly, click and drag the in one corner of the graphic.

2. A small blue box appearing under a word or character indicates that the fea-
ture was applied.

3. A is a miniature representation of all located graphics in the Clip Art task
pane.

4. The feature displays each page of your document in a reduced size so you can
see the page layout.

5. Tt is good practice to use only types of fonts in a document.
The default document settings are stored in the template file.
The at the top of the window contains commands that are organized into
related groups.

8. The feature shows how your formatting choices will appear on selected text.
Use when you want to keep your existing document with the original name

and make a copy with a new name.

10. Word 2010 documents are identified by the file extension.

MULTIPLE CHOICE

Circle the correct response to the questions below.

1. Words that are not contained in the main dictionary can be added to the
dictionary.
a. custom
b. additional
c. supplemental
d. user-defined

2. A(n) is text or pictures that appear behind document text.
a. graphic
b. watermark
c. embedded object
d. thumbnail

3. A(n) is a nontext element or object that can be added to a document.
a. illustration
b. picture
c. drawing

d. all of the above
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4. Document development follows these steps.
a. plan, edit, enter, format, preview, and print
b. enter, edit, format, preview, and print
c. plan, enter, edit, format, preview, and print
d. design, enter, edit, format, preview, and print
5. This feature makes some basic assumptions about the text entered and automatically makes changes
based on those assumptions.
a. AutoChange
b. AutoFormat
c. AutoText
d. AutoCorrect

6. When text is evenly aligned on both margins, it is
a. centered
b. justified
c. left-aligned
d. right-aligned

7. A set of characters with a specific design is called a(n)
a. style
b. font
c. AutoFormat
d. Design

8. Font sizes are measured in
a. inches
b. points
c. bits
d. pieces

9. The feature shows how various formatting choices would look on selected text.
a. Actual Preview
b. Real Preview
c. Active Preview
d. Live Preview

10. Words that may be spelled incorrectly in a document are indicated by a
a. green wavy line
b. red wavy line
c. blue wavy line
d. purple dotted underline
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STEP-BY-STEP N

* k& Difficult

ASKING FOR INPUT MEMO *

1. The Lifestyle Fitness Club is planning to perform maintenance work on its facilities in the near
future. You have been asked to solicit suggestions from existing customers about what changes they
would like to see made to the club. You decide to send all of the current club members a memo ask-
ing them for their input. Your completed memo will be similar to the one shown here.

a. Open a blank Word 2010 docu-
ment and create the following
memo in Draft view. Press after
you type the colon (:) in the memo
header. This will make the informa-
tion following the colons line up
evenly. Enter a blank line between

paragraphs.

To: Club Members
From: Student Name
Date: [Current date]

The Lifestyle Fitness Club is seeking to
improve some of its current facilities. Sev-
eral of the improvements we will make
next year fall under the category of routine
maintenance. For example, the current L/\/—\/_\
swimming pool has begun to age requiring

us to close the pool for a week to repair

several areas of cracking and chipping. We will be performing maintenance work on the sauna and steam room.
As we enter into this season of improvements, we’d also like your feedback on how we might serve you better.
For example, one member recently asked whether it would be possible to have additional tables near the snack
bar. All of your suggestions are welcome and will be considered in the upcoming months.

Thank you in advance for your input.

b. Correct any spelling and grammar errors that are identified.

c. Turn on the display of formatting marks. Check the document and remove any extra blank
spaces between words or at the end of lines.

d. Save the document as Fitness Club Memo in your solution file location.
e. Switch to Print Layout view.

f. At the beginning of the fourth sentence of the paragraph, insert the word “Simultaneously” fol-
lowed by a comma. Change the following “W” in “We” to lowercase. In the second to last sen-
tence of the paragraph, insert the words “and chairs” after the word “tables”. Delete the word
“current” from the first and third sentences.
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g. Start a new paragraph beginning with the fifth sentence.

h. Change the font size for the entire memo to 14 pt and the alignment of the body of the memo to
justified.

i. Turn off the display of formatting marks.

j. Add an ASAP watermark.

k. Include your name in the document properties as author and the file name as the title.

1. Save the document again and print the document.

PROMOTING CELEBRATE BIKES SUNDAY * *

2. You are the program coordinator for the city of Westbrook’s Parks and Recreation Department. In next
week’s newspaper, you plan to run an article to promote bike riding in the community through the
Celebrate Bikes Sunday event. Your completed article will be similar to the one shown here.

a. Enter the following information in a
new Word 2010 document. Press
at the end of each paragraph.

Celebrate Bicycling!

May is traditionally National Bike Month, so
take out your bicycle, tune it up and get a
breath of fresh air! And plan to take part in
Celebrate Bikes Sunday on 5/8 to learn about
the benefits of bike riding.

As part of the activities on this day, the
Westbrook Parks and Recreation Department
is sponsoring a bike ride from the West Ave-
nue YMCA to the Main Street Park beginning
at 11 am.

Businesses and organizations participating
in the event are all “related to biking in
Westbrook and most of them are involved in
the development of the trail system,” says
event director Mary Jo Miller.

At the end of the bike ride, the riders

are encouraged to stay for the fun and
informative activities in the park. Activities
include a bike safety program, entertainment,
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and food booths. The Safe Route to School program will work with parents and children to find the safest route
to either walk or bike to school.

Registration is free and available by calling (603) 555-0113, visiting the YMCA during regular business hours or
beginning at 10 am on Sunday at the YMCA.

b. Correct any spelling or grammar errors. Save the document as Bike Event.

c. Turn on the display of formatting marks. Check the document and remove any extra blank
spaces between words or at the end of lines.

d. In Print Layout view, center the title. Change the title font to Castellar (or a font of your choice),
22 pt, and light blue font color. Apply bold to the title.

e. In the first paragraph, delete the word “traditionally” and change the number 5/8 to “May 8.”
Add the text “and bicycle safety” to the end of the second sentence in this paragraph.

f. End the sentence in paragraph 3 after the word “Park”. Change the following sentence to “The
ride begins promptly at 11 am.”

g. Delete the phrase “the riders are encouraged to” from the first sentence of the fourth paragraph.

h. Move the paragraph beginning with “Businesses and organizations” to the second paragraph,
with “As part of the activities” becoming the third paragraph.

i. Add italics, bold, and light blue font color to the date in the first paragraph, the time in the third
paragraph, and the phone number in the last paragraph.

. Justify the paragraphs.

—.

k. Increase the font size of the paragraphs to 12 pt.
1. Insert a blank line below the title.

m. With the cursor on the blank line, insert a clip art graphic of your choice of a child riding a bike
by searching on the keyword “bike” or use the graphic file wd01_Child on Bike. Center it and
adjust the size of the graphic if necessary.

n. Add your name and the current date on separate lines several lines below the last line. Left-align
both lines. Turn off the display of formatting marks.

0. Review the document and, if necessary, adjust the size of the graphic to fit the document on a
single page.
p. Include your name in the file properties as author and the file name as the title.

q. Save the document again. Print the document.

ANNOUNCING MONTHLY MUSIC PERFORMANCES * *

3. The Downtown Internet Cafe combines the relaxed atmosphere of a coffee house with the fun of
using the Internet. The cafe will now be hosting monthly performances featuring local musicians.
You want to create a flyer about the monthly music performances that you can give to customers
and also post in the window of other local businesses. Your completed flyer will be similar to the
one shown here.
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You will also create the memo cov-
ersheet shown here using a Word
template. You will then give the memo
coversheet and flyer to Evan, the cafe
owner for review.

a. Open a new Word document and
enter the following text, pressing

where indicated.

Monthly music performances every fourth

Sunday!
Downtown Internet Cafe (2 times)

Come enjoy an excellent dark Italian Roast
coffee, premium loose teas, blended drinks
and quality light fare of sandwiches, pitas

and salads.

Your favorite coffeehouse has recently
added a superb sound system composed
of quality speakers and amplifiers. Starting
Sunday, January 24 at 3:00 p.m. we will be
hosting performances by local musicians.
Come by every fourth Sunday and be
entertained!

Cafe Hours: Sunday - Thursday 8:00 a.m. to
9:00 p.m. Friday and Saturday 8:00 a.m. to
12:00 a.m.

2314 Telegraph Avenue

b. Correct any spelling and grammar
errors that are identified.

c. Save the document as Music
Performances.

d. Turn on the display of formatting
marks. Center the entire document.

e. Capitalize each word of the first
line. Change the case of the text

“Downtown Internet Café” to
uppercase.

f. Using drag and drop, move the sec- . T >~ — ]

ond paragraph, including the para-
graph mark, to the left of “C” of “Come” in the previous paragraph.
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. Using cut and paste, move the street address, including the following paragraph mark, to the

“C” of “Café Hours”.

. Insert the following three lines of text between the first and second paragraphs:

February 28, West Coast Bluegrass Experience
March 28, Vocal String Quartet

April 25, International Guitar Night

. Change the first line of the document to a font color of dark red, font type of Arial Black or a

font of your choice, and size of 24 pt.

29

. Change the text “Downtown Internet Café” to a font color of blue, font type of Arial Narrow or a

font of your choice, and size of 28 pt.

. Select all the remaining text in the document and increase the font size to 14 pt.

. Change the three date lines below the first paragraph to a font color of purple and a font size of

16 pt. Change the last two lines (address and hours) to a font color of dark blue. Add bold to the
selection.

. Insert the graphic file wd01_Saxophone (from your data files) on the blank line below the title

Downtown Internet Café at the top of the document. Size the graphic to be approximately 2 by
2 inches using the ruler as a guide.

. Add your name and the current date, left-aligned, on one line, below the last line.
. If a paragraph mark is displayed to the right of the date, delete it.

. Turn off the display of formatting marks.

. If necessary, reduce the size of the graphic so the entire flyer fits on one page.

. Include your name in the file properties as author and the file name as the title. Save, print, and

then close the flyer document.

. Start a new document based on the Memo (Contemporary design) template.
. Delete the “CC” line of the memo.

. Edit the placeholders as follows:

To: Evan
From: your name

Re: Downtown Internet Café Flyer

. Edit the date, if necessary, to reflect the current date.

. Select the text below the horizontal border and then type Please review the attached flyer.

I’d like to begin handing the flyer out right away, so the sooner | receive your feedback, the
better. Thanks!

. Save the completed memo as Café Memo. Print the memo.
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PREPARING A LECTURE ON NOTE-TAKING SKILLS * * *

4. You teach a college survival skills class and have recently read about the results of a survey con-
ducted by the Pilot Pen Company of America about note-taking skills. The survey of 500 teenagers
found that students typically begin taking classroom notes by sixth grade and that only half had
been taught how to take classroom notes. It also found that those students trained in note-taking
earned better grades. Note-taking becomes increasingly important in high school and is essential
in college. Lecture notes are a key component for mastering material. In response to the survey,
the pen manufacturer came up with 10 tips for better note-taking. You started a document of these
tips that you plan to use to supplement your lecture on this topic. You will continue to revise and
format the document. The revised document will be similar to the one shown here.

a. Open the Word document
wd01_Note Taking Skills.

b. Correct any spelling and gram-
mar errors that are identified.
Save the document as Note
Taking Skills.

c. Switch to Draft view. Change
the font of the title line to a font
of your choice, 26 pt. Center and
add color of your choice to the
title line.

d. Apply the small caps effect to
the title line.

e. In the Be Ready tip, delete the
word “lots”. In the Write Legibly
tip, delete the word “cursive”
and add the words “an erasable”
before the word “pen.” Change
the tip heading “Margins” to
“Use Wide Margins.”

f. Above the Write Legibly tip,
insert the following tip:

Fill in Gaps

Check with a classmate or your
teacher after class to get any missing
names, dates, facts or other informa-
tion you could not write down.

g. Move the Fill in Gaps tip to after the Use Wide Margins tip.

h. Change the font of the tip heading lines to Broadway with a font size of 16 pt and a color of your
choice.

-

. Change the alignment of the paragraphs to justified. Use Undo Changes to return the alignment
to left. Use Redo Changes to return the paragraphs to justified again.
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j. Switch to Print Layout view. Insert a clip art graphic of your choice (search on “pencil”) below
the title, or insert the picture named wd01_Pencils from your data files location. Size it and cen-
ter it by referring to the completed document.

k. Add your name and the current date, centered, on separate lines two lines below the last line. If
needed, reduce the size of the graphic to fit the entire document on one page.

—_

. Include your name in the file properties as author and the document title as the title. Save the
document. Print the document.

WRITING AN ARTICLE ON THE HISTORY OF ICE CREAM * * x

5. Each month the town’s free paper prints a fun article on the history of something people are famil-
iar with but might not know anything about. You researched the topic online and found the infor-
mation you needed about the history of ice cream from the International Dairy Foods Association’s
Web site at www.idfa.org/mews--views/media-kits/ice-cream/the-history-of-ice-cream. You started
writing the article a few days ago and just need to continue the article by adding a few more details.
Then you need to edit and format the
text and include a graphic to enhance
the appearance of the article. Your com-
pleted article will be similar to the one
shown here.

a. Open the file named wd01_History of
Ice Cream.

b. Correct any spelling and grammar
errors. (Hint: Click [ ] in the status
bar to move to each error.) Save the
document as Ice Cream History.

c. Enter the following headings at the
location shown in parentheses.

History of Ice Cream (above first
paragraph)

The Evolution of Ice Cream (above
second paragraph)

Ice Cream in America (above third
paragraph)

d. Center the title “History of Ice
Cream”. Change the font to Lucida
Sans with a point size of 24, and add
the Small Caps effect. Add a color of
your choice to the title.

e. Change the other two headings to
bold with a type size of 14 pt. Use
the same color as in the title for the
heads.
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f. Move “The Evolution of Ice Cream” heading and paragraph to below the second “Ice Cream in
America” paragraph.

g. Undo the move operation you performed in the last step.
h. Change the alignment of the first paragraph to justified.

i. Add a blank line below the main title of the article and insert the picture wd01_Ice Cream (from
your data files) at this location.

j. Size the picture to be 1 inch wide (use the ruler as a guide). Center it below the title.
k. Add a Draft watermark.

1. Add your name and the current date below the last line of the article. View the whole page and,
if necessary, reduce the size of the graphic so the entire article fits on one page.

m. Include your name in the file properties as author and the document title as the title. Save the
document again. Print the document.

ONYOUR OWN

CREATING AFLYER *

1. Adventure Travel Tours is offering a great deal on a Day of the Dead Bicycle Tour in Mexico.
Research the Day of the Dead celebration using the Web as a resource. Then, using the features of
Word you have learned so far, create a flyer that will advertise this tour. Be sure to use at least two
colors of text, two sizes of text, and two kinds of paragraph alignment. Include a graphic from the
Clip Organizer. Include your name at the bottom of the flyer. Include your name in the file proper-
ties as author and the file name as the title. Save the document as Mexico Adventure.

CREATING A FAX COVERSHEET * x

2. You work at the community pool and have been asked by your boss (Anna Najarian) to fax some
information over to Asher Hayes at the local high school describing the rules swimmers should fol-
low when using the pool. Start a new document using the Fax (Equity theme) template. (If neces-
sary, open the wd01_Equity Fax template from your data files location.) Edit the template to include
the following recipient information: Asher Hayes (To:), 650-555-0198 (Fax:) 650-555-0197 (Phone:),
Pool Rules (Re:). Include the following sender information: Your Name (From:), 1 (Pages:),
Today’s Date (Date:), and Anna Najarian (CC:). Select the “For Review” check box by clicking on it.
(The box should appear shaded.)

Edit the Comments: placeholder to include the five most important rules to follow while swim-
ming at the pool. Use the Web as a resource for obtaining pool safety information. Place each rule
on separate lines. Insert a piece of clip art after the list of rules. Size the image if necessary so that
the document remains one page in length. Include your name in the file properties as author and
the file name as the title. Save the document as Pool Rules.
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ASTRONOMY CLASS MEMO * * *

3. The city of Gilbert, Arizona, has recently built a $100,000 observatory that includes a $20,000 tele-
scope in a local park. The observatory is open evenings for small groups of five to six people to take
turns looking through the 16-inch telescope’s eyepiece. The use of the observatory is free.

The city has decided to offer classes for the community to learn how to use the telescope and
to teach about astronomy. As a trial run, the class will first be offered to city employees and their
families. You want to notify all employees about the observatory and the class by including a
memo with their paycheck. Using Step-by-Step Exercise 1 as a model, provide information about
when and where the class will be held. Include information about how people sign up for the class.
Include your name in the file properties as author and the file name as the title. Save the memo as
Astronomy Basics.

VOLUNTEER OPPORTUNITIES * * %

4. Many community groups, hospitals, libraries, and churches are looking for volunteers to assist in
their programs. Volunteering has rewards for both the volunteer and the community. Using the
Web as a resource, research volunteer opportunities in your community. Then write a one-page
report that includes information about two volunteer groups for which you would like to volunteer.
Include information about what the organization does for the community. Also include the skills
you have to offer and the amount of time you can commit as volunteer. Include a title at the top of
the document and your name and the current date below the title. Center the title lines. Use at least
two colors of text, two sizes of text, and two kinds of paragraph alignment. Include a graphic from
the Clip Organizer. Include your name in the file properties as author and the file name as the title.
Save the document as Volunteer Opportunities.

WRITING A CAREER REPORT * * x

5. Using the library or the Web, research information about your chosen career. Write a one-page
report about your findings that includes information on three areas: Career Description; Edu-
cational Requirements; Salary and Employment projections. Include a title at the top of the
document and your name and the current date below the title. Center the title lines. Justify the
paragraphs. Include your name in the file properties as author and the file name as the title. Save
the document as Career Report.
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